
� El formato COMTRADE es un formato estándar usado en las para trabajar con
registros oscilográficos

� Un registro oscilografíco en formato COMTRADE esta compuesto por:

*.hdr Archivo de Encabezamiento, comentarios sobre el registro, opcional.

*.cfg Archivo de Configuración.

*.dat Archivo de Datos, muestreo.

*.dg4 Cambios personalizados, opcional.

EL FORMATO COMTRADE

*.dg4 Cambios personalizados, opcional.

*.rio Archivo de de ajuste de protecciones, opcional.

� Los datos para los archivos COMTRADE puede ser obtenidos de los registradores de
fallas, relés digitales y programas de simulación transitoria como el ATP, EMTP.

� Los estándares que definen el Formato COMTRADE son:

IEEE Std C37.111-1991 (Modificaciones en el 97 y 98)

IEEE Std C37.111-1999

Pueden ser de dos tipos ASCII ó BINARIOS se recomienda emplear los ASCII.
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� El Archivo de Encabezado “xxxxxxxx.HDR”

Este es un archivo de texto opcional creado por
el Originador de los datos COMTRADE,
típicamente a través de un editor de Texto como
el Notepad ó WordPad.

El creador del archivo de encabezado puede
incluir cualquier información que considere
necesaria ó importante.

Recursos para el Análisis de Perturbaciones
Archivos COMTRADE - El Formato COMTRADE

Guadalupe
Guadalupe

Guadalupe

Guadalupe

220 kV

necesaria ó importante.

Guadalupe
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� El Archivo de Configuración
“xxxxxxxx.CFG”

Este archivo contiene información
necesaria que para que un programa
computacional (SIGRA) interprete el
archivo de datos. Este archivo
contiene información tales como:

Antes de trabar con los archivos
COMTRADE se tiene que verificar los
siguiente:

Recursos para el Análisis de Perturbaciones
Archivos COMTRADE - El Formato COMTRADE

Guadalupe

� Nombre y Ubicación, Identificación del
registrador, año del Estándar.

� Numero y tipo de canales.

� Nombre de canales, Unidades, y factores de
conversión.

� Frecuencia de la línea.

� Tasa de muestreo y numero de muestras por
canal.

� Fecha y hora del primer punto de datos.

� Fecha y hora del punto de disparo

� Tipo de archivo de datos

� Time Stamp Multiplication Factor.

- Que las unidades sean A, V, kA, ó kV. Si
no fuera así reemplazarlos.
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� El Archivo de Datos “xxxxxxxx.DAT”

El archivo de datos contiene valores en filas y columnas donde cada fila consiste de
una serie de valores de datos precedidos por dos números que indican la posición y
el tiempo de ocurrencia. Este archivo debe tener el mismo nombre de los archivos
de encabezamiento y de configuración y su extensión es "DAT“.

Recursos para el Análisis de Perturbaciones
Archivos COMTRADE - El Formato COMTRADE
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SIGRA es un programa incluido dentro del DIGSI, este programa es usado para analizar
eventos en formato COMTRADE.
Las variables se pueden representar de las siguientes formas:

Diagramas en func. del tiempo Diagramas vectoriales

Recursos para el Análisis de Perturbaciones
Archivos COMTRADE
Trabajando con Oscilografías y Archivos COMTRADE

©Todos los derechos reservados por Red de Energía del Perú S.A.

Diagramas Circ. (Z y P) Armónicos

Tabla de datos
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Para cargar el SIGRA:
Inicio/programas/Siemens Energy/SIGRA 4.3

Cuando se abre, el programa le preguntara si desea asignar canales, haga click

Recursos para el Análisis de Perturbaciones
Archivos COMTRADE
Trabajando con Oscilografías y Archivos COMTRADE

Cuando se abre, el programa le preguntara si desea asignar canales, haga click
en “SI”, si ya están asignados no aparecerá esta pantalla.
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Asigne las señales:
IL1, IL2, IL3, IE
UL1E, UL2E, UL3E
para obtener todas señales analógicas
disponibles.

En algunos casos se puede obviar IE.

Asignando señales y configurando el “SIGRA”

Recursos para el Análisis de Perturbaciones
Archivos COMTRADE
Trabajando con Oscilografías y Archivos COMTRADE

En algunos casos se puede obviar IE.
K1: nos representa la línea 1.
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Valores para el cálculo de impedancia:

Si desea calcular la impedancia fase a
tierra ingrese los valores RE/RL y XE/XL.

Recursos para el Análisis de Perturbaciones
Archivos COMTRADE
Trabajando con Oscilografías y Archivos COMTRADE
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Asignar línea acoplada:

Si tiene línea paralela con acoplamiento
mutuo ingresar los valores de:

RM/RL y XM/XL.

Donde la línea K1 es acoplada con uno

Recursos para el Análisis de Perturbaciones
Archivos COMTRADE
Trabajando con Oscilografías y Archivos COMTRADE

Donde la línea K1 es acoplada con uno
de las líneas K.
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Cargar un segundo registro:

1. Cargar el primer registro.
2. Edit -> Fault record -> Add (abrir el nuevo registro)
3. Ok

Recursos para el Análisis de Perturbaciones
Archivos COMTRADE
Trabajando con Oscilografías y Archivos COMTRADE
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Sincronizar dos registros:

1. Sincronizar los dos registros.
2. Edit -> Synchronous Fault Records
3. Ok

Recursos para el Análisis de Perturbaciones
Archivos COMTRADE
Trabajando con Oscilografías y Archivos COMTRADE
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Convertir dos archivos comtrade en Uno:
1. File -> Comtrade Export…
2. Seleccionar señales
3. Save, nombrar y ubicar

Para exportar todo el registro, primero en:
View -> Zoom -> optimize

Recursos para el Análisis de Perturbaciones
Archivos COMTRADE
Trabajando con Oscilografías y Archivos COMTRADE
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Localización del relé SIEMENS:

Recursos para el Análisis de Perturbaciones
Archivos COMTRADE
Trabajando con Oscilografías y Archivos COMTRADE
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1. View -> Fault locator
2. Ok

Localización de fallas:

Recursos para el Análisis de Perturbaciones
Archivos COMTRADE
Trabajando con Oscilografías y Archivos COMTRADE
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Recursos para el Análisis de Perturbaciones
Archivos COMTRADE
Trabajando con Oscilografías y Archivos COMTRADE
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Archivo .rio:

P2
P3

P4

Recursos para el Análisis de Perturbaciones
Archivos COMTRADE
Trabajando con Oscilografías y Archivos COMTRADE

Se puede adicionar mas puntos, el
polígono forma en forma según la
secuencia ingresada en forma anti
horaria.

Fase

tierra

P1
P2
P3
P4
P5

P1

P5
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Metodología y criterios para el Análisis de Perturbaciones
Normatividad
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Casos Aplicativos: Fallas en Líneas de Transmisión
Recierre exitoso de la Línea L-2232 Trujillo – Chimbote
Descripción del evento
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EVENTO: Recierre monofásico exitoso de la fase "S" en la Línea L-2232 
(Chimbote - Trujillo 220 kV). 

DÍA: Ocurrida el 13 de marzo de 2010 a las 07:34 a.m.
UBICACIÓN: 75.6 km de la SE. Chimbote
CONSECUENCIA: No hubo restricción de suministro. Las protecciones se 

desempeñaron correctamente.
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AR CLOSE Cmd.
Relay TRIP L2
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Casos Aplicativos: Fallas en Líneas de Transmisión
Recierre exitoso de la Línea L-2232 Trujillo – Chimbote
Condiciones Operativas previas.
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Casos Aplicativos: Fallas en Líneas de Transmisión
Recierre exitoso de la Línea L-2232 Trujillo – Chimbote
Registro de oscilografías
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Casos Aplicativos: Fallas en Líneas de Transmisión
Recierre exitoso de la Línea L-2232 Trujillo – Chimbote
Registro de SOE rele 
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Casos Aplicativos: Fallas en Líneas de Transmisión
Recierre exitoso de la Línea L-2232 Trujillo – Chimbote
Diagrama de impedancia durante la falla
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Casos Aplicativos: Fallas en Líneas de Transmisión
Recierre no exitoso de la Línea L-2232 Trujillo – Chimbote
Descripción del Evento y Zona de análisis
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EVENTO: Recierre monofásico no exitoso de la fase "S" en la Línea L-2232 
(Chimbote - Trujillo 220 kV). 

DÍA: Ocurrida el 10 de marzo de 2010 a las 07:29 a.m.
UBICACIÓN: 79.1km de la SE. Chimbote
CONSECUENCIA: No hubo restricción de suministro. Las protecciones se 

desempeñaron correctamente.
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Casos Aplicativos: Fallas en Líneas de Transmisión
Recierre no exitoso de la Línea L-2232 Trujillo – Chimbote
Condiciones previas
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Casos Aplicativos: Fallas en Líneas de Transmisión
Recierre no exitoso de la Línea L-2232 Trujillo – Chimbote
Registro de oscilografías
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Casos Aplicativos: Fallas en Líneas de Transmisión
Recierre no exitoso de la Línea L-2232 Trujillo – Chimbote
Diagrama de impedancia durante la falla
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Casos Aplicativos: Fallas en Líneas de Transmisión
Desconexión de la Línea L-1008 Tintaya – Callalli falla bifásica
Descripción del evento
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EVENTO: Desconexión de la línea L-1008 (Callalli – Tintaya) de 138 kV. 
debido a falla bifásica RS a tierra

DÍA: Ocurrida el 19 de marzo de 2010 a las 06:22 p.m.
UBICACIÓN: 14.2 km de la SE. Callalli
CONSECUENCIA: No hubo restricción de suministro. Las protecciones se 

desempeñaron correctamente.
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Casos Aplicativos: Fallas en Líneas de Transmisión
Desconexión de la Línea L-1008 Tintaya – Callalli falla bifásica
Condiciones previas
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Casos Aplicativos: Fallas en Líneas de Transmisión
Desconexión de la Línea L-1008 Tintaya – Callalli falla bifásica
Registro de oscilografías
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Casos Aplicativos: Fallas en Líneas de Transmisión
Desconexión de la Línea L-1008 Tintaya – Callalli falla bifásica
Diagrama de impedancia durante la falla
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Casos Aplicativos: Fallas en Líneas de Transmisión
Desconexión Línea L-1122 Tingo María - Aucayacu
Configuración del Sistema Tingo María – Aucayacu - Tocache

EVENTO: Falla monofásica en la fase “R” de la línea L-1122 (Tingo María –
Aucayacu)

DÍA: 9 de diciembre de 2008
HORA: 22:07:52 horas
UBICACIÓN: 29.9 km de la SE. Tingo María
CONSECUENCIA: Desconexión de la línea L-1122 y transformador T28 de la SE. 

Aucayacu. 
Desconexión de la línea L-1124 (Aucayacu Tocache 138kV) . 
Interrupción del servicio de Aucayacu y Tocache
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Casos Aplicativos: Fallas en Líneas de Transmisión
Desconexión Línea L-1122 Tingo María - Aucayacu
Descripción del Evento

� Se produce una falla monofásica en la fase “R” de la línea L-1122. La misma se
produjo debido a una pérdida de aislamiento en una cadena de aisladores debido a
una descarga atmosférica a 29.9 km de la SE. Tingo María.

� Las cargas en Aucayacu y Tocache era de 1 MW y 2.2 MW respectivamente.

� La línea L-1122 es de 44.2 km y la L-1124 de 107.8 km .

� Sistema radial desde Tingo María hasta Tocache, con baja transferencia de carga.

� Potencia de cortocircuito en Tingo María 138kV igual a 2.3 kA.
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� A los 531 ms desconecta el transformador T28-162 por actuación de su protección
de sobrecorriente a tierra

Casos Aplicativos: Fallas en Líneas de Transmisión
Desconexión Línea L-1122 Tingo María - Aucayacu
Descripción del Evento
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� A los 605 ms la protección 21 de la línea L-1122, en la SE. Tingo María ordena
disparo trifásico del interruptor IN-2472 (aparentemente en tiempo de zona 2).

� Solo abrieron las fases “R” y “T”.

Casos Aplicativos: Fallas en Líneas de Transmisión
Desconexión Línea L-1122 Tingo María - Aucayacu
Descripción del Evento
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� A los 2.42 s al continuar la fase “S” del interruptor IN-4272 cerrada actúa la
protección de discordancia de polos ordenando disparo trifásico, sin embargo el
interruptor continuó cerrado.

� A los 3.63 s se produjo la desconexión de la línea L-1124 por actuación de su
protección de sobretensión

Casos Aplicativos: Fallas en Líneas de Transmisión
Desconexión Línea L-1122 Tingo María - Aucayacu
Descripción del Evento
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� Se interrumpió el servicio de las cargas alimentadas desde las subestaciones
Aucayacu y Tocache.

� El interruptor IN-4272 se cerró a las 22:10:57 reponiendo la línea L-1122 (3 minutos
después de la falla) empezando la recuperación de los suministros interrumpidos de
manera normal.

� La fase “S” del interruptor IN-4272 no abrió.

Casos Aplicativos: Fallas en Líneas de Transmisión
Desconexión Línea L-1122 Tingo María - Aucayacu
Descripción del Evento
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� La línea L-1122 en la SE. Tocache no contaba en la fecha de la falla con protección
alguna por lo que el interruptor IN-4080 siempre queda cerrado para eventos de falla
en la línea. Esto porque el sistema Tingo María – Aucayacu – Tocache era
totalmente radial.

� La protección de la línea L-1122 en la SE. Tingo María no contaba con esquema de
recierre (sistema radial).

� La protección de la línea L-1122 constaba con un solo relé de distancia (7SA511)

Casos Aplicativos: Fallas en Líneas de Transmisión
Desconexión Línea L-1122 Tingo María - Aucayacu
Análisis de la Falla: Cuestiones Adicionales a tener en Cuenta 
para el Análisis
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� La falla ocurre a 22.9 km de la SE. Tingo María, esta falla se encuentra al 67.6% de
la línea, por lo que se encuentra dentro de la zona 1 de la protección de distancia
(ajustada generalmente al 85% de la línea), debiendo actuar en tiempo instantáneo.

Casos Aplicativos: Fallas en Líneas de Transmisión
Desconexión Línea L-1122 Tingo María - Aucayacu
Análisis de la Falla: Reconstrucción del Evento
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� Del diagrama de impedancia del relé observamos que la falla ingresa a la zona 1,
sin embargo la protección dispara recién a los 605 ms. de ocurrido el evento.

Casos Aplicativos: Fallas en Líneas de Transmisión
Desconexión Línea L-1122 Tingo María - Aucayacu
Análisis de la Falla: Reconstrucción del Evento
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� Se pueden formular las siguientes preguntas:

� ¿Porqué el relé no actuó de forma instantánea si la impedancia de falla se
encuentra en la zona 1?

� ¿Acaso el relé actuó en zona 2?

� ¿Actuó mal el relé?

� Se debe ahondar en el análisis para responder estas preguntas.

Casos Aplicativos: Fallas en Líneas de Transmisión
Desconexión Línea L-1122 Tingo María - Aucayacu
Análisis de la Falla: Reconstrucción del Evento
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�Del mismo diagrama anterior, se observa que la
impedancia de las fases sanas se encuentran cercanas a
las zonas de disparo de la protección de distancia.

Casos Aplicativos: Fallas en Líneas de Transmisión
Desconexión Línea L-1122 Tingo María - Aucayacu
Análisis de la Falla: Reconstrucción del Evento
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� De la oscilografía de la protección 21, se observa un aumento de corrientes en las
fases sanas “S” y “T” producto de la falla. No se observa mayor cambio en las
tensiones.

Casos Aplicativos: Fallas en Líneas de Transmisión
Desconexión Línea L-1122 Tingo María - Aucayacu
Análisis de la Falla: Reconstrucción del Evento
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� De las señales digitales de la protección 21, se observa que el relé inicialmente
detecta la falla como reversa y luego de la desconexión del T28-162 recién la ve
adelante.

Casos Aplicativos: Fallas en Líneas de Transmisión
Desconexión Línea L-1122 Tingo María - Aucayacu
Análisis de la Falla: Reconstrucción del Evento
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� De información recogida del manual del relé 7SA511 respecto a su criterio de
selección de fase fallada se tienen tres condiciones necesarias para su operación:

� La impedancia de la fase fallada debe encontrarse dentro de la zona ajustada
en el relé para tal fin.

� La corriente de las fases falladas debe superar un umbral de corriente Iphmin>
de ajuste mínimo para ser tomadas en cuenta.

� Si existiera más de un lazo en falla que cumpla con las dos condiciones
anteriores, entonces el relé considera válidos únicamente aquellos cuya

Casos Aplicativos: Fallas en Líneas de Transmisión
Desconexión Línea L-1122 Tingo María - Aucayacu
Análisis de la Falla: Reconstrucción del Evento

anteriores, entonces el relé considera válidos únicamente aquellos cuya
impedancia no sea mayor que el lazo que registre la menor impedancia.

� Para la falla analizada, se cumplieron las tres condiciones para las fases “R” (donde
ocurrió la falla) y la “T”.
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� El relé detectó una falla “RTN”, priorizando el lazo de la fase “T”, por lo que la falla
fue tomada en zona reversa (impedancia fase “T” ubicada hacia “atrás”)

Casos Aplicativos: Fallas en Líneas de Transmisión
Desconexión Línea L-1122 Tingo María - Aucayacu
Análisis de la Falla: Reconstrucción del Evento
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� A los 531 ms, la corriente por la fase “T” disminuyó a 59A por lo que a partir de
ese instante el relé ve la falla hacia adelante ordenando el disparo instantáneo
por zona 1.

Casos Aplicativos: Fallas en Líneas de Transmisión
Desconexión Línea L-1122 Tingo María - Aucayacu
Análisis de la Falla: Reconstrucción del Evento
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� A los 605 ms con la apertura de las fases “R” y “T” el sistema es liberado de la falla
pero la línea queda energizada por la fase “S”, cuyo polo no aperturó por problemas
mecánicos en el interruptor IN-4072.

Casos Aplicativos: Fallas en Líneas de Transmisión
Desconexión Línea L-1122 Tingo María - Aucayacu
Análisis de la Falla: Reconstrucción del Evento
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� No se cuentan con más registros de la protección de distancia de la línea L-1122.
Sin embargo se cuenta con un registrador de fallas instalado en la SE. Tingo María
el cual permite registros mayores de tiempo.

Casos Aplicativos: Fallas en Líneas de Transmisión
Desconexión Línea L-1122 Tingo María - Aucayacu
Análisis de la Falla: Reconstrucción del Evento
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� Las sobretensiones registradas alcanzan valores de 1.52 p.u., valor que supera la
tensión máxima de soportabilidad en régimen continuo de los pararrayos
(generalmente este límite está entre 1.2 y 1.3 p.u. de la tensión nominal de
operación).

� La obtención de estas oscilografías y su respectivo análisis fue posible gracias a la
información recogida del registrador de fallas en la SE. Tingo María.

Casos Aplicativos: Fallas en Líneas de Transmisión
Desconexión Línea L-1122 Tingo María - Aucayacu
Análisis de la Falla: Reconstrucción del Evento
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� Se efectuó la revisión del interruptor IN-4072 encontrándose un problema mecánico
en los topes de accionamiento de la fase “S” (se encontraban rotos).

� Reducir el ajuste de corriente Iphmin> en la protección 7SA511 para evitar que
fallas de este tipo no sean detectadas en zona reversa y sean despejadas
adecuadamente. Se ajustó en 95 A después de realizar varias simulaciones.

� En vista de lo anterior, se recomendó subir la temporización de la protección 51N del
transformador T28-162 para evitar que fallas externas al mismo sean despejadas en
tiempos menores a 700ms.

Casos Aplicativos: Fallas en Líneas de Transmisión
Desconexión Línea L-1122 Tingo María - Aucayacu
Análisis de la Falla: Acciones Correctivas 

tiempos menores a 700ms.

� Se recomendó medir las corrientes de fuga en los pararrayos de la línea L-1122 para
detectar si estos equipos habían sido afectados luego de la sobretensión producto
de la falla.
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MANTARO COTARUSE SOCABAYA
XC2

XC1 XC3

XC4B2 B3

B1 B4

XL12
XL13

IP5

IP7

IP8
IP2

IP1

IP4

IP3

L-2052

L-2051 L-2053

L-2054

Casos Aplicativos: Fallas en Líneas de Transmisión
Pérdida de la Interconexión Mantaro - Socabaya
Configuración Interconexión Mantaro - Socabaya 

XL11 XL14

IP6

SEIN
SUR

L-2051 L-2053

EJEMPLO DE ESTADO DE  
INTERRUPTORES

A Cerrado

B Abierto

C AbiertoEVENTO: Falla trifásica en la línea L-2053 y falla 
monofásica en la línea L-2054

DÍA: 18 de marzo de 2007
HORA: 13:54:57 horas
UBICACIÓN: 187.2 km de SE Socabaya
CONSECUENCIA: Pérdida de la interconexión Mantaro-Socabaya
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MANTARO COTARUSE SOCABAYA
XC2

XC1 XC3

XC4B2 B3

B1 B4

XL12
XL13

IP5

IP7

IP8
IP2

IP1

IP4

IP3

L-2052

L-2051 L-2053

L-2054

Casos Aplicativos: Fallas en Líneas de Transmisión
Pérdida de la Interconexión Mantaro - Socabaya
Configuración Pre – Falla

XL11 XL14

IP6

IP1 IP3

EJEMPLO DE ESTADO DE  
INTERRUPTORES

A Cerrado

B Abierto

C Abierto

SEIN
SUR

L-2051 L-2053

� Líneas L-2051, L-2052, L-2053 y L-2054 en servicio.
� Reactores XL11, XL12, XL13 y XL14 en servicio.
� Banco compensador XC2 fuera de servicio.
� Banco compensador XC1, XC3 y XC4 en servicio.
� Autotransformador T1 y T2 en servicio.
� Se transmitía 244,0MW de Cotaruse a Socabaya.
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L-2054

MANTARO COTARUSE SOCABAYA
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1Ø

L-2052

Casos Aplicativos: Fallas en Líneas de Transmisión
Pérdida de la Interconexión Mantaro - Socabaya
Configuración en Proceso de Falla
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MANTARO COTARUSE SOCABAYA

DISPARO MONOFÁSICO

“INICIO PROCESO DE RECIERRE”

L-2052 L-2054

Casos Aplicativos: Fallas en Líneas de Transmisión
Pérdida de la Interconexión Mantaro - Socabaya
Configuración en Proceso de Falla

DISPARO TRIFÁSICO

SEIN
SUR

59

MVTU

DTT

L-2053

EJEMPLO DE ESTADO DE  
INTERRUPTORES

A Cerrado

B Abierto

C Abierto
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MANTARO COTARUSE SOCABAYA

“PROCESO DE RECIERRE”

L-2052 L-2054

Casos Aplicativos: Fallas en Líneas de Transmisión
Pérdida de la Interconexión Mantaro - Socabaya
Configuración en Proceso de Falla

DISPARO TRIFASICO

SEIN
SUR

L-2051 L-2053
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MANTARO COTARUSE SOCABAYA

“RECIERRE EXITOSO”

L-2052 L-2054

Casos Aplicativos: Fallas en Líneas de Transmisión
Pérdida de la Interconexión Mantaro - Socabaya
Configuración en Proceso de Falla

SEIN
SUR

L-2051 L-2053
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MANTARO COTARUSE SOCABAYA

OSCILACIÓN DE POTENCIA

21

SEL-321

L-2052

DTT

DISPARO TRIFÁSICO

Casos Aplicativos: Fallas en Líneas de Transmisión
Pérdida de la Interconexión Mantaro - Socabaya
Configuración en Proceso de Falla

SEIN
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L-2051 L-2053
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MANTARO COTARUSE SOCABAYA

L-2052 L-2054

Casos Aplicativos: Fallas en Líneas de Transmisión
Pérdida de la Interconexión Mantaro - Socabaya
Configuración en Proceso de Falla

SEIN
SUR

L-2051 L-2053
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� Como consecuencia de una falla de estas características se presentó el año 2005 y
fue analizado con simulaciones y presentado al COES por el Consorcio
Transmantaro.

� En ese informe se propusieron medidas para atenuar el efecto de las
sobretensiones, minimizando el riesgo de la desconexión de la interconexión, las
cuales fueron implementadas en el campo.

� Las sobretensiones armónicas en la fase “C” de la L-2051 en la S.E. Cotaruse son

Casos Aplicativos: Fallas en Líneas de Transmisión
Pérdida de la Interconexión Mantaro - Socabaya
Análisis de la Falla

Las sobretensiones armónicas en la fase “C” de la L-2051 en la S.E. Cotaruse son
provocadas por un fenómeno de resonancia (Informe Transmantaro).

� La resonancia se presenta cuando una fase está conectada en antena, conectado
desde la S.E. Mantaro o conectado desde la S.E. Cotaruse.
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� Las fallas simultáneas en las líneas L-2053 y L-2054 fueron provocadas
por fuertes descargas atmosféricas.

� La falla trifásica en la línea L-2053 fue despejada correctamente por su
protección diferencial de línea con disparo trifásico definitivo.

� La falla monofásica en la línea L-2054 fue despejada correctamente con
disparo monofásico seguida de un recierre exitoso.

� La línea L-2051 fue desconectada correctamente por su protección de
sobretensión en la S.E. Cotaruse debido a la presencia de

Casos Aplicativos: Fallas en Líneas de Transmisión
Pérdida de la Interconexión Mantaro - Socabaya
Conclusiones

sobretensión en la S.E. Cotaruse debido a la presencia de
sobretensiones armónicas en la fase “C”, conectada en antena.

� La línea L-2054 desconectó en la S.E. Cotaruse por actuación de su
protección de distancia debido a una pérdida de sincronismo entre los
generadores del Sistema Centro-Norte y Sur del SEIN.
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� Se produjo una falla monofásica
en la fase T cuya causa y
ubicación se desconocía.

Análisis de fallas en Líneas de Transmisión
Colapso Zona Este 05 de Diciembre de 2010
Descripción del Evento

ubicación se desconocía.

� Esa falla provoco el colapso del
SEIN – Zona Este.
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Análisis de fallas en Líneas de Transmisión
Colapso Zona Este 05 de Diciembre de 2010
Zona de Análisis
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Análisis de fallas en Líneas de Transmisión
Colapso Zona Este 05 de Diciembre de 2010
Condiciones Operativas Previas
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Zona 2 � Forward.

RELE DE DISTANCIA

RELES DE DISTANCIA
Carhuamayo

L-2265
Falla monofásica fase T.
Zona 4 � Reverse.

RELES DE DISTANCIA
Paragsha

L-2254
Falla monofásica fase T.
Zona 4 � Reverse.

RELES DE SOBRECORRIENTE
T37-211 Paragsha

Análisis de fallas en Líneas de Transmisión
Colapso Zona Este 05 de Diciembre de 2010
Localización de la falla de acuerdo a los relés

el Perú S.A.
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El análisis del relé 
87B indica que la 
falla no fue en la 

Barra
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Análisis de fallas en Líneas de Transmisión
Colapso Zona Este 05 de Diciembre de 2010
Localización de la falla de acuerdo a los relés
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Análisis de fallas en Líneas de Transmisión
Colapso Zona Este 05 de Diciembre de 2010
Localización de la falla de acuerdo a los relés
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Análisis de fallas en Líneas de Transmisión
Colapso Zona Este 05 de Diciembre de 2010
Actuación de los relés
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Análisis de fallas en Líneas de Transmisión
Colapso Zona Este 05 de Diciembre de 2010
Actuación de los relés
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� Con el análisis efectuado a las 60 horas de ocurrido el evento, ya se tenia la
seguridad que la falla monofásica de la fase T no fue en ninguna de las
instalaciones de REP.

� Las líneas L-2254, L-2258, L-2259, L-1121 y L-1120 desconectaron como
respaldo ante una falla no despejada.

� La desconexión de las línea L-1121 y L-1120 fue por perdida de sincronismo.
El proceso oscilatorio se produjo a través del enlace débil de 138 kV entre la
CH. Gera y los motores de Antamina contra el SEIN.

Análisis de fallas en Líneas de Transmisión
Colapso Zona Este 05 de Diciembre de 2010
Conclusiones

CH. Gera y los motores de Antamina contra el SEIN.
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SOBRETENSIONES TEMPORALES

Proceso de recuperación del sistema Este luego 
del Colapso
05 de diciembre de 2010 – 10:10 a.m.
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� Durante la reposición del sistema Este, luego de un colapso. Los
operadores intentaban recuperar la carga de Antamina, a través de las
líneas en 138 kV debido a que las líneas L-2253 y L-2254 estaban
indisponibles.

Análisis de fallas en Líneas de Transmisión
Colapso Zona Este 05 de Diciembre de 2010
Reposición del sistema Este - 05 de diciembre de 2010 9:38 a.m
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� Estas maniobras provocaron oscilación de tensión en Vizcarra, de
acuerdo a los registros se tiene que la tensión oscilaba entre 183 kV y
266 kV.
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Tensión línea a línea en Vizcarra
Valores instantáneos
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� La frecuencia de oscilación de tensión fue de 7.4 Hz.

� Oscilación de tensión entre 183 kV y 266 kV.

� El operador procede a desconectar el SVC de Vizcarra.

U/kV

250

Análisis de fallas en Líneas de Transmisión
Colapso Zona Este 05 de Diciembre de 2010
Reposición del sistema Este - 05 de diciembre de 2010 9:38 a.m

UL12* UL23* UL31*

-0.70 -0.60 -0.50 -0.40

50

100

150

200

Registro de tensiones de línea a línea valores RMS en Vizcarra
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� Impedancia armónica en Vizcarra y Tingo María bajo las condiciones
presentadas en el evento.

� Se observa que la impedancia armónica esta cerca de la frecuencia industrial.

Análisis de fallas en Líneas de Transmisión
Colapso Zona Este 05 de Diciembre de 2010
Reposición del sistema Este - 05 de diciembre de 2010 9:38 a.m
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ENERGIZACIÓN DE UN TRANSFORMADOR DE 
POTENCIA

Energización del transformador de Potencia T15-261 Piura
21 de diciembre de 2010 10:29 a.m.
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� Luego de un mantenimiento programado en el transformador T15-261,
este debe entrar a operar en paralelo con el transformador T32-261.

Cierre del 
interruptor

Análisis de fallas en Transformadores
Energización del transformador T15-261 Piura
21 de diciembre de 2010 10:29 a.m.
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iL1-M1/A

0
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� Estas corrientes pueden activar la protección diferencial del transformador.

� En el plano Idiff/Irest se puede ver como registra el relé diferencial la
corriente diferencial y la corriente de restricción.

Análisis de fallas en Transformadores
Energización del transformador T15-261 Piura
21 de diciembre de 2010 10:29 a.m.
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� Las alta corriente generada por energización (corrientes de inrush) puede
producir disparos indeseados de la protección diferencial.

� Por la naturaleza de la forma de onda de una corriente Inrush estas corrientes
tienen un alto contenido de componente 2da armónica, ppor lo cual se ajusta
la función de bloqueo o restricción por 2do armónico el cual bloquea el
disparo de la protección diferencial durante la energización.

I/A

Análisis de fallas en Transformadores
Energización del transformador T15-261 Piura
21 de diciembre de 2010 10:29 a.m.
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Registro de corriente Inrush T15-261 – Contenido armónico.
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Cuando un transformador es energizado, se
presenta una corriente de energización
transitoria (Inrush).

Esta corriente transitoria de magnetización
puede ser de 8 a 30 veces la corriente
nominal del transformador.

� ¿A que se debe esta corriente?

Análisis de fallas en Transformadores
Energización del transformador T15-261 Piura
21 de diciembre de 2010 10:29 a.m.

nominal del transformador.

Los factores que determinan la duración y
magnitud de la corriente de magnetización
son:

�Capacidad del transformador
�Localización del transformador
�La resistencia en el sistema de potencia.
�El tipo de hierro y su densidad de
saturación.
�El nivel de flujo residual del transformador
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CARACTERISTICAS DE LOS NUCLEOS EN TRANSFORMADORES

Análisis de fallas en Transformadores
Energización del transformador T15-261 Piura
21 de diciembre de 2010 10:29 a.m.

Característica de magnetización B-H de núcleo
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DESCONEXIÓN DEL TRANSFORMADOR DE POTENCIA 
T9-261 HUANCAVELICA

17 de diciembre 2010 10:43 a.m. .
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� Las líneas que van desde Mantaro a Independencia van juntas en la
misma torre, la longitud de estas líneas es de 248 km.

� En el intermedio de la línea L-2204 se encuentra la subestación
Huancavelica.

� Se produjo una falla monofásica simultanea en la fase S.

Análisis de fallas en Transformadores
Desconexión T9-261 SE Huancavelica 17 de diciembre 2010 10:43 a.m. 
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� Operación de las protecciones.

Análisis de fallas en Transformadores
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Un fenómeno curioso es que durante una falla monofásica las corrientes en el devanado de alta del
transformador se ponen se alinean decir están en fase.

Este fenómeno es conocido como la paradoja de Bauchs.

Análisis de fallas en Transformadores
Desconexión T9-261 SE Huancavelica 17 de diciembre 2010 10:43 a.m. 
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Los registros oscilograficos muestran las tres corrientes R, S y T prácticamente en fase.
Es por este fenómeno que la corriente de neutro llega a tres veces el valor de la corriente de fase.

Análisis de fallas en Transformadores
Desconexión T9-261 SE Huancavelica 17 de diciembre 2010 10:43 a.m. 
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Oscilografia del transformador T9-261 Huancavelica, lado de 220 kV.
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Como actúo el relé de sobrecorriente ante esta falla.

Análisis de fallas en Transformadores
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SATURACIÓN DEL TRANSFORMADOR DE POTENCIA 
TINGO MARIA

AT-01 Tingo María
05 de diciembre de 2010 9:38 a.m.
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-200

-100

0
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El siguiente registro oscilografico muestra la presencia de corriente de magnetización en el
transformador de Tingo María.
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Se puede apreciar el contenido armónico de la corriente, principalmente el quinto armónico.
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Las propiedades magnéticas del núcleo
determinan la corriente de excitación,
debido a las propiedades no lineales

Análisis de fallas en Transformadores
Saturación del transformador AT-01 Tingo María
05 de diciembre de 2010 9:38 a.m.

debido a las propiedades no lineales
del hierro, la forma de onda de la
corriente de excitación difiere de la
forma de onda del flujo.

Corriente de excitación y la 
tensión aplicada al primario
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Análisis de fallas en bancos de capacitores
Corrientes de Energización en capacitores  SE Chimbote
Descripción de la instalación el 17/09/2008
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� Aleatoriamente, al energizar un segundo banco BC-2 (15MVAR) en la SE 
Chimbote, salía de servicio el que ya se encontraba operando BC-1 (20MVAR), 
actuaba el relé de sobrecorriente.

Análisis de fallas en bancos de capacitores
Corrientes de Energización en capacitores  SE Chimbote
Descripción del caso
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� La tensión en los terminales de un condensador no puede variar instantáneamente.

� Al energizar un banco con tensión inicial cero, se puede producir un cambio muy 
grande en la tensión dependiendo del punto de tensión en donde se energice.

� Este cambio abrupto de tensión produce una gran corriente transitoria en el banco, a 
una frecuencia natural determinada por la capacitancia del banco y la inductancia del 
sistema asociado. 

� Para entender conceptualmente el fenómeno se puede estudiar el circuito mostrado, 
el sistema es representado con una fuente DC debido a que la frecuencia del 

Análisis de fallas en bancos de capacitores
Corrientes de Energización en capacitores  SE Chimbote
¿Que fenómenos suceden al energizar un banco de 
condensadores?: corriente de energización

el sistema es representado con una fuente DC debido a que la frecuencia del 
transitorio es muy grande comparada con la frecuencia del sistema (60 Hz).

U

L

C

Datos del sistema eléctrico
Scc : 349,55 MVA
Impedancia de Thevenin: 0.0444 ohm
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� Se simuló la energización de los bancos considerando el efecto resistivo del sistema 
para encontrar el tiempo que dura el transitorio.

800

3400

6000

[A]

Corriente de energización fase "A" del BC1

Análisis de fallas en bancos de capacitores
Corrientes de Energización en capacitores  SE Chimbote
Simulación de energización de un banco con ATP 

(f ile chimbote.pl4; x-var t)  c:X0097A-CAP-1A     

0.00 0.05 0.10 0.15 0.20 0.25 0.30[s]

-7000

-4400

-1800

� La corriente inrush o de energización de los BC está entre 7 y 8 veces la corriente 
nominal de los bancos de condensadores.
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� Se desprecia la fuente de tensión del 
sistema y se considera una pequeña 
inductancia que representa a la conexión 
entre ambos condensadores y las 
capacitancias están en serie,

F
FF

FF

CC

CC
Ceq µ

µµ

µµ
38.119

93,20857,278

93,20857,278

21

21
=

+

×
=

+

×
= Inductancia

Cable monofásico 1,08 microH/m
Cable trifásico 0.24 microH/m

Valores aproximados de inductancia 

C1 C2
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Corrientes de Energización en capacitores  SE Chimbote
Energización de un banco estando el otro en servicio

F

L

kV
I

cable

inrush

µ38,119

3
28,13 ×

=

Cable trifásico 0.24 microH/m
Seccionador 0.8 microH

Interruptor
Especificada por el 

fabricante

Casos L (microH)
Corriente 
Inrush kA 

pico

Frecuencia de la 
corriente Inrush

kHz
1 1,08 118,46 14
2 1,5 100,5 11.89
3 2,0 87,05 10.29
4 2,5 77,86 9.21
5 3,0 71,0 8.4
6 3,5 65,8 7.78
7 4,0 61,55 7.28

La corriente de energización está 
entre 100 y 130 veces la corriente 
nominal
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� Una conclusión importante: 

La corriente que circula por los bancos es la misma… si un banco no sale 
fuera de servicio porque salía el otro.

� Resulta que la temporización no era la misma…

Análisis de fallas en bancos de capacitores
Corrientes de Energización en capacitores  SE Chimbote
Que se puede decir…
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� Se simuló el peor caso (L=1,5 �H)  
considerando amortiguamiento

U

0

20

40

60

80

[kA]

Corriente inrush BC1, con BC1 en servicio

Corriente inrush en el condensador BC1 
considerando amortiguamiento (L=1,5 �H, 
R=0.001)
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Corrientes de Energización en capacitores  SE Chimbote
Simulación con ATP Conexión de un condensador, 
estando el otro en servicio

(file chimbote2.pl4; x-var t)  c:CAP1A -1A     c:CAP1B -1B     c:CAP1C -1C     

0.00 0.03 0.06 0.09 0.12 0.15[s]

-80

-60

-40

-20

0
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Corriente inrush BC2, con BC1 en servicio

Corriente inrush en el condensador 
BC2 considerando amortiguamiento 
(L=1,5 �H, R=0.001)
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� La norma ABNT (Asociación 
Brasilera de Normas Técnicas) toma 
en cuenta las corrientes transitorias 
de la tabla en la energización de 
bancos de condensadores

Análisis de fallas en bancos de capacitores
Corrientes de Energización en capacitores  SE Chimbote
Pero, será adecuado aumentar la temporización del otro 
banco…

� De acuerdo a la norma los bancos soportan las corrientes transitorias de acuerdo a la 
cantidad de veces de energización por año.

� Para el caso de los bancos BC-1 y BC-2 de Chimbote en el que la corriente inrush
esta alrededor de 130 veces la corriente nominal, se recomienda que el número de 
energizaciones no sobrepase de 400 veces por año según la norma ABNT.

� Para tener un dato exacto del límite del número de energizaciones, debe considerarse 
los datos del fabricante de los bancos de condensadores (Nissin Electric).
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� Los relés de los bancos por ser de tecnología electromecánica antigua no cuentan 
con filtros, por lo tanto son afectados por las corrientes elevadas de inserción de los 
bancos.

� Es posible reajustar el tiempo de operación de los relés de protección.

BANCO DE CONDENSADORES N� 1 de 20Mvar

Relés de sobrecorriente: (TC: 1000/5)

Análisis de fallas en bancos de capacitores
Corrientes de Energización en capacitores  SE Chimbote
Comportamiento del Sistema de Protección en la 
Energización de los Bancos

Relés de sobrecorriente: (TC: 1000/5)

Relés de sobretensión: 10 V

Relé de Voltage Overvoltage 125 V, Undervoltage 80 V.

Relés auxiliares 152TX 159T: 10 Seg., 164VT: 10 Seg., 130T: 0.10 Seg

BANCO DE CONDENSADORES N� 2 de 15 Mvar

Relés de sobrecorriente: (TC 100/5)

Relés de sobretensión: 10 V

Relés auxiliares 252TX 259T :7 Seg., 264VT: 5 Seg., 230T: 0.095 Seg
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� La energización de dos bancos conectados a una misma barra produce una corriente 
de inserción de igual magnitud en ambos bancos de condensadores.

� La frecuencia de la corriente inrush para la conexión de un banco estando el otro en 
servicio es mucho mayor a la corriente producida la energizar un banco y se debe 
básicamente a la reducción de la capacitancia total y a la baja inductancia de la 
conexión entre bancos.

� Se recomienda no energizar el banco de los bancos de condensadores más de 400 
veces por año, así como tener un registro del número de energizaciones por año.

Análisis de fallas en bancos de capacitores
Corrientes de Energización en capacitores  SE Chimbote
Conclusiones y recomendaciones.

veces por año, así como tener un registro del número de energizaciones por año.

� Se recomienda aumentar el tiempo de operación de los relés de sobrecorriente de los 
bancos BC1 y BC2 a 150ms y efectuar pruebas para garantizar su desempeño.

� Se recomienda reemplazar los relés de los bancos BC1 y BC2 por relés numéricos 
que tengan oscilografía.  
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Descripción de la instalación
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Desconexión de los bancos de la SE Chavarría 02/08/2010
Descripción del caso

� De manera intempestiva desconectaron ambos bancos de condensadores de la 
SE Chavarría, al revisar los bancos no se registraba falla interna.
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El esquema de protección de los bancos
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Desconexión de los bancos de la SE Chavarría 02/08/2010
El registro de actuación del relé que efectuaba el disparo
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Análisis de fallas en bancos de capacitores
Desconexión de los bancos de la SE Chavarría 02/08/2010
Comentarios después de ver la información

� ¿Se presentaba alguna falla intermitente en el banco?

� ¿La causa de la falla era interna o externa?

� ¿Qué tipo de disturbios generaban las desconexiones del banco?

� ¿Será posible que la función de desbalance de neutro actúa ante 
tensiones/corrientes desbalanceadas en las fases?
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Desconexión de los bancos de la SE Chavarría 02/08/2010
Comentarios después de ver 1000 veces la información se 
llegó a las siguientes conclusiones

� Se registro que la salida del banco coincidía con fallas en líneas de distribución 
cercanas a la subestación Chavarría.

� Una falla monofásica causaba un desbalance en las tensiones de las fases del banco.

� El relé que protegía el banco contenía un función back up que se basa en la medición 
del desbalance de corrientes de fases las cuales se origina por suministro de 
tensiones desbalanceados.  tensiones desbalanceados.  

� Se analizó la posibilidad de reajustar esta función o deshabilitarla.

� La función back up no era necesaria ya que al contar el banco con dos piernas es 
mejor la función de desbalance de neutro en la conexión de las dos piernas (para un 
esquema de protección …mientras mas simple … mejor) entonces se deshabilito.
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